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Chapter 1 Getting Started

General Information
SpaceMan integrates space-related data to floor plans so that you can produce
graphic representations of their data in an easy-to-use and cost-effective way.   The
end result is that users of space-related data are no longer dependent on computer
specialists to produce sophisticated graphics such as color-coded floor plans.

The method for allocating
rentable space to the tenant.
Incorporating all facilities
within the building to
increase gross RSF pricing.

In addition, SpaceMan provides powerful tools that calculate available square
footage; derive available square footage for a new or existing building; or to demise
space and obtain the available square footage for the demised space.  There are many
applications for these tools such as “gaming” a property, “growing” a building's
rentable square footage (RSF), or obtaining instantaneous RSF calculations as part of
the leasing effort. SpaceMan is flexible in the methods that you can use to calculate a
building RSF. Essentially you can use any formula or method that suits your
properties needs.

SpaceMan uses an industry-standard relational database, Microsoft's Access, for
storing and retrieving data. This allows you to work with data created by any third
party package that can be uploaded into an Access database file.

Please note that although the examples we use are for an office property, the same
procedures apply to retail and industrial floor plans as well. We use an office
property because it best represents the features that SpaceMan offers.

PlanData’s Services
Most companies use PlanData's SpaceMan software services for extensive space
documentation of their properties. These services range from converting existing
CAD files into SpaceMan; producing the CAD files for your company; field
measuring properties; or document the tenant partitioning of space to help in the
leasing effort. If you would like more information on these services, please contact
PlanData at 1.800.757.BLDG or visit us on our Web Site.

Platform
SpaceMan is a 32 bit Windows based application program and will run on either
Microsoft Windows 95/98/NT/2000/XP. To run SpaceMan, double click on the
PlanData logo icon that was installed to your desktop. If you encounter difficulties,
please contact PlanData at 1-800-757-BLDG
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Minimum Hardware Requirements
Due to the fact that SpaceMan is a graphic application, the more power your
computer has, the better. Almost equally important is the availability of RAM. The
minimum requirements for running SpaceMan are:

Pentium Processor

64 MB of RAM required (128Mb recommended)

Up to 30Mb of hard disk space for installation

Logging On
SpaceMan requires a User ID along with a password. Your System Administrator can
set up your access.

User ID: XXX

Password: XX

SpaceMan Editions
Ø SpaceMan/Professional Full working version.

Ø SpaceMan Full function except user can not save work back into main
database.

Ø Demo can not save anything and is limited to the projects OFFICE,
OFFICE TOWER, RETAIL, PROTO and INDUSTRIAL.

For further information on user rights see section on Administrative Rights.

SpaceMan Licensing
When you buy a copy of SpaceMan from PlanData Systems, you are issued a license
ID and a serial number. Every time SpaceMan is opened the license ID and serial
number are checked. If they are not valid, the program will open to the demonstration
mode only.
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Terms and Standards

Attribute
An attribute refers to the characteristics of a specific type of data. For example: if
PlanData Systems Corp. were the data entered, an attribute of PlanData would be a
phone number, an address, or any other characteristic.

Data Menu
A data menu appears when you place the cursor on the floor plan and right click. The
selections listed on the data menu are called data tables.

Data Tables
Data tables are used to display and edit information stored in the database. Click on
any of the selections listed on the data menu to open a data table. You may edit the
listed records that are attached to this space

Field
It is an individual element of data.

Input Screens
Input screens are used when adding or modifying data. These screens are designed to
be user friendly, to make their use as easy as possible. We have incorporated drop
down lists when we require particular values in a field to further extend ease of use.
Input screens are used when adding or modifying data.

List Boxes
List boxes are provided whenever the system uses a pre-determined selection. Click
on the drop-down arrow, located next to the text box to display the selections. When
the appropriate choice is highlighted, click on OK. Click on the Cancel button to
escape from making changes, and you will return to the previous screen.

Record
Record is a group of fields (grouped by some similarities).

Relational Database
A Relational Database is a set of tables, grouped by similarities and associated by
common references between them. For our purposes, when we use the term
“database” we are referring to a relational database.
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Table
Is a grouping (or set) of records. Think of a table as a matrix that has fields as
columns and records as rows. Also sometimes referred to as a "file".

Using the Keyboard for Menu Commands
While using the mouse is the most convenient method for selecting SpaceMan
functions, alternative keyboard commands are provided.  Ex. Press Alt + F to open
the File menu

Using a Mouse in SpaceMan
In this section we will discuss how the mouse is used within the SpaceMan software.
The manufacturer, upon installation of the peripheral, provides standard
configuration for the mouse.

The Left or Right mouse “Click”

SpaceMan uses the left button on your mouse as the selection button. By convention,
throughout this documentation we will refer to the left mouse click as a “click”. You
will be asked to make selections with either a “single” or “double” click.

Alternatively, you may be asked to “right click” to perform certain actions. Use the
right mouse button when directed.

The Data Retrieval/Cancel Button

Use right click to retrieve information about spaces on the floor plan. Place the
mouse pointer on the selected room, rights click the mouse, and pop-up menu will
appear. Selecting different items from the menu will allow you to assign or receive
information about that particular space.

A right click is also used to cancel the mode you are currently working in. E.g., if
you are in the middle of adding a label to a space, right click will exit from that
mode.

Pull-Down Menus
Pull-Down Menus are hidden under each of the main menu bar selections. Click on
one of the menu selections to view a list. Each command on the list has a
corresponding alternative keyboard short cut. Press Alt + the underlined letter of the
list selection. To close a list, press the Esc key or click off the bar.

To work with a pull down menu:

Place the cursor on the desired menu bar selection.

Scroll down the list to highlight the desired function.

Follow the directions in the dialogue box provided.

Backing up Data
It is advisable to keep data on your system on “removable media.” Copies should be
kept on something other then your hard drive in the event something happens to your
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system (i.e. your hard drive fails). Discuss backing up your files with your System
Administrator for standard procedures. Most organizations have guidelines for
backing up data. Different organizations have different hardware available for these
operations.

As a security measure, administrators are given the rights to backup both the
SpaceMan drawings and the database. When an administrator wants to backup work,
they must save the entire directory since a project is a directory.

See Defining User Privileges/Administrative Rights

Viewing Space-Related Data
The single-most important aspect of SpaceMan is its ability to connect data to floor
plans in an easy-to-use fashion. This allows you to use the floor plan essentially as a
menu for viewing data.

Viewing or Editing Data
SpaceMan has the ability to track a large amount of information assigned to a space
and allows you to view, add and modify space related information.

To view or edit the data that SpaceMan has stored about a
particular space:

1. Place the mouse pointer over the desired space and right click (the
space should become highlighted).

2. From the list box select the table you want to view, add or edit
including attaching documents such as excel, word files, etc. (Note that
the check mark indicates that data has been entered. When no check
mark appears you will be adding data for the first time. )

3. Review/modify the information in the table.

4. Click on Close or press Esc to return to the drawing.

Drawing Terms and Conventions
Select from the list a term to view its definition and the action you may perform.

Projects
Projects are groupings of buildings and/or properties. Projects are important for
setting up your system, and running reports. Projects help you define the summaries
for “rolled-up” reporting. You can use this feature to group properties that share a
site (i.e. a campus-style property), or you can use it to group properties in a given
region or portfolio. This is the highest level of the hierarchy of data.  SpaceMan
creates a sub-directory (folder) for each project.  All data files for the project exist in
that sub-directory.
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Buildings
A Building is a structure that consists of multiple floors. A project can contain any
number of buildings.

To View File
To Generate Reports
To Create Graphics
To Creating a New Project

Floors
Floors are within a building.

Scenario Files
SpaceMan allows you to create Scenario Files. A Scenario File is a copy of the
original CAD file, with all related database records for the project, property, building
or floor. Scenario files can be used to test some ideas with respect to the drawings,
such as demising partitions, etc. It is important to note that this information can not
be merged back into the main database.

File Naming Convention
SpaceMan uses the S_M extension for master files and SMS extension for scenario
files. Do not try to modify these extensions yourself, or otherwise these files will
become unaccessible from SpaceMan. There are no other limits on file names.

Cursor Types
SpaceMan uses a variety of cursors depending on the task being performed or the
mode you are in. The following is a brief description of each cursor type.

Note: To cancel out of the specific mode or operation, simply press the ESC
(Escape key) or right click.

The Cursor, This command mode allows you to perform the most
basic operations of the system (pulling-down menus, selecting icons,
etc.). The Cursor is most prevalent one used in SpaceMan and is
used during the command mode.

Zoom Window Cursor, When you are ready to zoom into a
selected portion of a drawing the cursor changes to a dotted cross
hair.

Draw mode Cursor, When you enter the graphic mode, the cursor
changes to a cross hair. In this mode you can add/modify certain
graphic elements of the drawing (i.e. adding a boundary line).

Edit Cursor, When you are in the edit mode (i.e. when changing
assignment information), the cursor becomes a hand holding a pen.

Move cursor, When you move text or assignments the cursor will
become a pointing hand. This makes it possible for you to specify the
location that you want to move the information from and the location
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that you want to move the information to.

Add/View Pictures Cursor, When you select either Add or View
Pictures from the Pictures pull-down menu, the cursor will become a
camera. To add a picture, place the cursor approximately where the
photograph was taken with the camera cursor. The Add Picture screen
will appear prompting for information. If you want to view a picture
already referenced in the database, point to one of the camera
symbols on the screen using the camera cursor, and the photograph
will appear on your screen.

Delete Cursor, When you are in the graphic mode and the cursor
changes into a target symbol, you can delete graphic elements  (i.e.
walls, assignments that are no longer desired).

   Hourglass Cursor, This cursor type appear when the system is busy
performing some task. Generally you should wait until computer is
done with its task and cursor returns back to the standard type.

Opening/Retrieving a Drawing
In this section we will view some of the options associated with opening floor plans.

Show File Descriptions check box
Show file descriptions gives you the option to view detailed information SpaceMan
stores about a building or a floor plan. You may find this more convenient then
referring to files names that the system uses. We will discuss building and floor plan
descriptions in later chapters, specifically in Advanced Functions.

Show Scenario Files check box
Check Show Scenario Files box to display the list of scenario files (*.SMS) in a
project. Uncheck it if you want to see master files (*.S_M).

Selecting a Building / Floor
The list of available projects is dispalyed on the left-hand side of the form, the list of
floor plans in the selected project is displayed on the right-hand side.

To select a floor plan to open, select a project on the left side, then select desired
floor plan on the right. To open highlighted floor plan, click the OK button or double
click the floor plan.. SpaceMan will display your floor plan in the drawing window.

The Drawing Window and Default View
By default, SpaceMan will open a drawing window with the entire floor plan
displayed. This window allows you to perform drawing tasks. You can change the
current view and zoom factor by selecting one of the magnifying icons, located on the
tool bar.
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Chapter 2 Command Reference

The main menu bar spans the top of the Spaceman Window. The selections to
functions within the program are grouped in pull-down menus under each of the main
menu selections. Click on a menu bar selection to view a pull-down list.

File
Contains general management commands such as; opening and closing drawing files;
exiting the program; printing drawings; and configuring the system.

New Project
Creates a new project directory. You can only select New Project when there is no
project open.

See section “Creating a New Project”

New Drawing
Creates a new SpaceMan drawing.

Open Drawing
Allows you to select a drawing to work on.

Close Drawing
Allows you to close the drawing that you are working on.  SpaceMan will prompt
you to save changes to the drawing before closing.

Save
Saves the current drawing.
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Save As
Allows you to save the current drawing under a different name, or in a different
directory.

Print
Opens the “Print Preview” dialogue where you will be able to select printer, setup
printing options, and print out the floor plan.

Setup
Selecting Setup will bring the form to help you to configure your system. It contains
five tabs that you can click on in order to alter different aspects of the SpaceMan
software.

Click on Setup from the File pull-down menu. When you click on one of the tabs
located in the System Setup screen it will be pulled to the front so that you can work
on it.

Utilities
This option on the File menu only appears when there is no drawing open in the
system.  The options given under Utilities are:

Import Data.
In order for SpaceMan to display the most accurate and timely information,
SpaceMan allows you to import data from other sources (i.e. from your property
management accounting systems, etc.).  For maximum flexibility, SpaceMan has
many different methods for importing data, which varies based on the source and
type of data that you plan on importing

Print Utility
This command allows you to select the drawing you would like to print and
determine its color-coding scheme.  Select the Color Code tab to choose the color-
coding.  More than one type can be selected by holding down the Control key and
choosing the types you want.  Press print when you are ready.

Create Scenario Utility
This command, allows you to select files for scenario creation.  You can choose from
those listed on the Existing tab, or those given on the recent tab.  When done, press
Create.

Backup Project
It is always a good idea to periodically backup a project.  This command creates a
backup (zip file) of your project files.  It is recommended that the user select all three
file types (database, SpaceMan files, and CAD drawings).  Note:  Scenario files are
not to be backed up.
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Restore Project
This option restores a project backup created using the Backup Project command.
All files will be restored to the selected directory even if they resided in different
locations when the backup was created.  If the file being restored exists, the user will
be prompted to over write.

Repair Database
If you try to repair a database because it corrupted for some reason ( i.e. power
failure) and you can not open it in SpaceMan, open the sample database shipped with
SpaceMan, go to the Utilities menu  > Repair database, and select suspect
database.

Compact Database
This command reclaims unused space within the database, resulting in a smaller file
size.  Compact Database is a Microsoft Access Utility.

Options on the System Tab:

The system tab allows you to modify the default display settings of your drawing.

Turn on or off the layer function.

Change how a Reference CAD file is displayed.

Change the colors of items in the floor plan.

The hatch scale refers to the distribution of space allocated between gradation lines
when you divide a space.

Add extra length to boundary lines drawn in.

Print timestamp on B/W drawings

Label Leaders will allow an assignment to be moved outside a delineated space and a
line leader will be automatically be drawn.

Boundary Dimensions can be displayed automatically.

Change how SpaceMan displays text with different fonts.

Options on the Drawing Tab:

Select the underlying CAD file for your SpaceMan floor plan.

Select the unit of measurement for your drawing so that SpaceMan can calculate the
area.

Select the underlying CAD file for your SpaceMan floor plan.

Select the unit of measurement for your drawing.

Determine the unit of measurement for the CAD file.
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Options on the Directories Tab:

Specify the default directories where SpaceMan stores projects, CAD files, pictures,
reports, temporary files and security database.

Options on the DDE (Dynamic Data Exchange) Tab

This screen allows you to setup parameters for SpaceMan to exchange data with
other Windows programs that support DDE. If this option is enabled, SpaceMan
adds the name of the program to establish DDE conversation with to the data menu
which pops-up when you right-click on a space. The specified program will
automatically start and receive in specified form (topic), and in specified controls
(item 1 and item 2)  project name and lease ID of the selected space.

PlanData Systems uses this feature to enable communication between SpaceMan
software and LeaseMan software. If you are interested in connecting SpaceMan with
any other software package, please contact PlanData Systems.

Options on the License Tab:

The License tab allows you to enter your license ID and serial number. You can also
view access rights of a current user.

Export
Allows you to copy the graphic image to a text file or to export the SpaceMan entities
into an AutoCAD .DWG file.

To Copy Screen Image to Clipboard:

Zoom to the area you want to copy and select File/Export/Copy Screen Image to the
clipboard. All visible in the window floor plan area will be copied to the clipboard.
You can switch to another application (e.g. MS Word, Excel, etc.) and copy image
into the document in that application. Generally, you will be able to do this by
selecting Edit > Paste or by pressing Ctrl-C in that application.

Your selection will remain on the clipboard until you replace it by copying another

Create Bitmap file

Allows you to save a bitmap image of the current SpaceMan file.

Write SpaceMan Entities to DWG file

Allows you to save all SpaceMan entities as AutoCad drawing.
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Write EMF file

Allows you so save an EMF file of the current SpaceMan file to disk.

View
The View pull-down menu contains various commands that enable you to move and
size your drawing window. Icons on the main tool bar represent shortcuts to each of
these commands.

Viewing SpaceMan Drawings
SpaceMan opens a drawing considered the default view. This view is set to allow you
to see the entire floor and any title information that is associated with the drawing.
Many times, this is not a practical way to work with the drawing since it would be
very difficult to accurately select elements in the drawing at such a small scale. For
this reason, SpaceMan has tools that allow you to enlarge areas of the drawing as
well as ways to move around the drawing

Zoom In
The zoom in command is used to enlarge the center of your screen by 50 percent.
This command reduces the scope of the area that you are viewing so that you can see
a detailed portion of your floor plan. Go to Zoom In, located on the View pull-down

menu or click on the zoom in icon . Zoom in allows you to enlarge the floor plan
in 50% increments.

Zoom Out
The zoom out command reduces the screen by 50 percent. Use the zoom out tool to
extend the field of vision on a floor plan. Go to Zoom Out located on the View pull-

down menu or click on the zoom out icon .

Zoom All
Allows you to see the entire floor plan in the default view.

Zoom Previous

Restores the previous zoom setting .

Zoom Window
Allows you to zoom in on a specific portion of the screen.

The zoom window command is used to zoom in on an area (or window) that you
define. To start this command, select View > Zoom Window from the menu bar
pull-down menu or click on the zoom window icon, then select area to zoom and
right click.
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The status and helpful hints bar at the bottom of the screen will say, “Enter corner
point.” To select the portion that you wish to enlarge, you must create a window (or
box) that defines this area.

To work with the Zoom Window:

1. Click on the  Zoom Window Icon.

2. Click while positioning the cursor on the corner of the area that you
wish to enlarge.

3. Drag the cursor diagonally to the opposite corner of your selection. You
will see a box expanding around the area of your selection. When you
capture the area, click again.

SpaceMan will redraw the screen, showing only the area that you captured
for view.

To return to the original view, go to the View pull-down menu and select
Zoom Default View or click on the  default view icon.

Zoom Default View
PlanData set the default view in order for you to view the entire floor plan or any
area of your interest. Please note that when a floor plan is open the first time, the
default view is chosen to allow user to see all entities on the floor plan.

To work with Zoom Default View

Select View > Zoom Default View from the pull-down menu or click on the 

Zoom default icon.

Layer Manager
Allows you to see different combinations of layers of the CAD & SpaceMan files.

You use the Layer Manager command to:

• Make individual layers, ranges of layers or all layers to be displayed or
hidden on the screen.

• Restore initial displayed/hidden state of the layers.

This command is used to control which information in the reference file (CAD) is
displayed. To turn a Reference layer on or off, select View > Layer Manager from
the menu bar or click on the  Layer Manager icon.

 The Layer Manager box appears on your screen. Check On column for the layers
that you want to see, and uncheck it for those you do not want to see.  Click Apply
button if you want to see the changes in the display without leaving Layer Manager,
and OK if you want to apply changes and close Layer Manager.

Alternatively you may hide a layer by clicking on  Utilities > Show Entity Layer,
then select on the screen a line that belongs to the layer you want to turn off. A
dialogue box will pop-up asking if you want to hide this layer, select Yes.
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Pan
This command will allow the user to move around the drawing by sliding the current
display around.

Redraw Screen
Redraws the screen, without changing the view.

This command is used to redraw your current screen. You may notice that sometimes
your drawing contains small lines (or marks) left over from deletions. If you redraw
the screen, these marks will disappear. To redraw your screen:

Select View > Redraw Screen from the menu bar or

Click on the Redraw magnifying glass .

Regen Screen
Regenerated all entities on the screen display. Generally, Regen will take longer than
Redraw, but will completely rebuild the view of the drawing you work with.

Set Default View
A default view is the view that you see when you open the drawing or when you click
on the default view icon. You can set the default view 2 ways:

To set Current View:

Prints the same view of the drawing that you see on the screen.

To set By Window:

Set by window allows you to select a partial area of the drawing to use as
the default view. For instance, if you spend most of yout time  working
on the specific area of the drawing, you can set this area as you default
view.

1. Select View > Set Default View > By Window from the menu bar.

2. Click to set a starting point for the cross hair cursor.

3. Drag the cross hair cursor over the area you want to set as the new
view.

4. Click again when you have captured the area within the box.

To set By Coordinates:

1. Select View > Set Default View > By Coordinates from the menu bar.

2. Type the X min and X max coordinates.

3. Type the Y min and Y max coordinates.

4. Click OK.
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Symbol Origins
Places an X symbol at the origin point of all symbols in a CAD file. E.g., a typical
symbol used in drawings would be an I-beam used for a column. When symbols like
these are built, the origin is normally placed on the column center. Symbol origins
allows you to determine a insertion point of a symbol.

Boundary

Accuracy Tool Bar
The selections on this toolbar will allow you to be very precise in the placement of
boundaries. Below is an explanation of the icons displayed on the Accuracy Toolbar.

Add Boundary
When you click on Add Boundary from the Boundary pull-down menu or the
boundary icon, SpaceMan will display the Accuracy Tool Bar.

Convert CAD Entity
This feature allows you to convert lines from your reference file to SpaceMan
boundary lines. This is a quick and easy way to draw SpaceMan lines using CAD
entities as a reference.

Single Line

Select a line in the background CAD file line and SpaceMan will add its own line to
the drawing. Sometimes it is convenient to have extra length added to a converted
line, to have it “extended”. To do it, make sure before converting that you have extra
length specified in File>Setup >System Tab>Convert line extra length, inches.

From your Menu Tool Bar

Select  Boundary >Convert CAD Entity > Single Line.

From the Accuracy Toolbar 

Select Snap to CAD Entity Icon  then the Convert Single CAD Line  .

SpaceMan will add this length to both ends of CAD lines when converting them. If
you do not want to have extra length added, set extra length to 0 in Setup.

Lines in Window

Select a window with CAD lines you want to convert. SpaceMan will find all CAD
file lines with both ends within the selected area and convert them. If line extra length
is set, SpaceMan will ask your confirmation to proceed, convert all lines, and then
“extends” them.

From the Menu Tool Bar
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Select  Boundary >Convert CAD Entity > Lines in Window.

Line to Centerline Wall

This feature is especially helpful if you have two parallel lines that represent a wall
thickness in your CAD reference file, for which you want to demise the space to the
centerline of that wall. Zoom into the two parallel lines then select one of them.
SpaceMan will add a centerline between them, and if extra length is specified, it will
extend it.

From your Menu Tool Bar

Select  Boundary >Convert CAD Entity > Lines to CenterLine Wall.

From the Accuracy Toolbar 

Select the  Snap to CAD Entity Icon  then

select the Convert CAD Lines to Centerline  .

Arc to Lines

Since SpaceMan works only with lines it will approximate CAD arcs to a number of
straight lines; the more lines the better the approximation.

From your Menu Tool Bar

Select  Boundary >Convert CAD Entity>Arc to Lines.

Select an arc from the CAD reference entities. SpaceMan will calculate a
recommended number of lines and ask whether you want to proceed with it or set
another number. Once the number is set, SpaceMan will add lines approximating to
the selected arc.

Edit Boundary
The Edit Boundary command allows you make minor changes so that you don’t
have to delete and recreate a boundary. The Edit Boundary Parameters box allows
you to decide which layer the boundary belongs to, and determine where that
boundary begins and ends. You can toggle between the Defines area and will be
printed functions for a particular boundary by clicking on the appropriate radio
button. If you designate a boundary as not able to define area, the boundary will
become a dotted line.

Edit all Boundary’s allows the user to change all spaceman lines to Set All Printable,
Set All to Non Printable and Set All Widths.

Trace Boundary
This diagnostic tool helps you determine where partitions do not close by tracing the
outline of a space. For example, You created a wall, and now you want to calculate
the area. When you right click for calculations on the area, SpaceMan does not
recognize the newly created space. The new boundary doesn’t completely close the
space. Trace Boundary will help you determine where the break occurs.
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To Trace a Boundary:

1. Select Boundary > Trace Boundary from the menu bar.

2. Position the cursor in the area that you want to check.

3. Click within the space.

SpaceMan will begin tracing the intersecting boundaries until all connecting
boundaries are highlighted. Boundaries not highlighted are not connected. Close the
space with the Add Boundary tool, then right-click to recalculate the space.

Delete Boundary
Deletes a boundary from the drawing. If you accidentally delete a boundary that you
want in the drawing select Undo Last Delete, and it will reappear.

Delete Nibs in Window
Deletes boundaries that do not start and end on other boundaries. This command is
recursive; you should save your file before using it.

Delete Boundaries in Window
Deletes all boundary lines within a window that you specify.

Undo Last Delete
Will recover items accidentally deleted.

Assignments

Add Assignments
Assigns data to the specified space in the drawing.

To Add Assignments:

From the Menu Bar.

1. Select Assignments > Add Assignments from the Menu Bar
or left-click on the Add Assignment Icon .

2. Select the space you want to Add an Assignment to.

3. You will see a dialog box.

Convert CAD Assignments
Adds a space assignment or a group of assignments to the drawing. Rather than
pointing to the location and entering the space ID, you enclose the multiple pieces of
text within a window in the CAD reference file. SpaceMan will add the assignments
using the text value as the space ID.
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If this function does not work, see Explode Symbols from the Utilities pull-down
menu.

Edit Assignment
Allows you to change the label parameters (such as size or style) of a selected space.

Edit All Assignments
Like the edit function described above, but changes the labels for all of the spaces on
the floor plan.

Move Assignment
Allows you to change the location of a label by clicking on the space label that you
want change and then clicking to the new location for the label.

Delete Assignment
Allows you to change the location of a label by clicking on the space label that you
want change and then clicking to the new location for the label.

Deletes a label from the drawing. By removing a label from the drawing, you are
breaking the link between SpaceMan and Access for that space.

Delete Assignments in Window
Deletes all assignments within a user-defined window.

Recalculate Area
Recalculates the Rentable Square Footage for the floor.

Show Area
Displays the net, adjusted, and chargeable area of a selected space.

Show Assigned
Highlights all the stores that have been assigned labels. To clear, click on Redraw
Screen.

Show Unassigned
Highlights all the stores that have not been assigned labels. To clear, click on
Redraw Screen.
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Text
Allows you to add, edit, move or delete text. Text is displayed on the screen; it does
not affect the database.

Note:  The difference between text and assignment information, assignment
information links a space to the database, while text is written material located on the
screen that is not linked to the database.

To Add Text:

Go to the Text pull-down menu, and select Add Text

The cursor will change to the edit cursor.

Click on the area of the drawing where you would like to place the text.

The Add Text screen will appear. From this screen you can:

• Load a text file.

• Select a typeface, bold and/or italic.

• Select text alignment, left, right or center justified.

• Choose the size and rotation of the text.

Type the text that you would like to appear in the text box provided.

When finished, click on the OK button and the text will appear. If you decide that
you don't want to enter text, click on the CANCEL button.

Show Text
Allows you to toggle between viewing the added text or not.

Edit Text
Allows you to edit text in the drawing. Click on the text you want to edit and the
dialogue box will appear. Make your changes and click OK.

Move Text
Allows you to move text from one location on the drawing to another.

Delete Text
Allows you to remove text from the drawing.

Delete Text in Window
This command will delete all text within a user-defined window.
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Picture
SpaceMan gives you the option to link photographs of a building site, floor plan,
interiors, and views to your database. To enhance presentations you can view these
photos to clarify information. This is achieved by linking a photographic view to a
camera icon which you can place in a drawing. This icon can be rotated so that the
user knows the perspective from which the photo is taken.

 The Aerial icon – signals a picture taken from above and usually used for

maps.

 The Camera icon – used for regular pictures attached to the floor plans

Show Pictures/Hide Pictures
The menu selection allows you to toggle on and off  displaying camera icon on the
site plan. When switched on you can view camera symbols in preset locations.

View Pictures
Allows you to view actual building photographs assigned to a selection on the
drawing.

To view a picture:

If View Pictures appears inactive, click on Show Picture Symbols to activate
the View Picture menu selection.

Click on View Picture to change cursor to the camera icon. Or Click on the

icon located on the tool bar. 

Click on one of the pre-set camera icons  on the drawing to view the

photograph.

Click close picture to return.

Check the Aerial Picture box to add a site aerial view.

To Add a picture:

1. Click on Add picture

2. Place the  camera cursor on the location for which you are adding a

view.

3. Click to place a camera icon  on the drawing.

4. Select a file name from the drop down list.

5. Type a comment in the text box provided.

6. Select a camera angle you want to appear.

7. Click OK.
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A new  camera icon  will appear on your drawing.

To Delete a Picture:

1. Click on delete picture.

2. Place the target icon on the camera you want to omit.

3. Click on the camera.

Graphics

Generating Graphics
The color graphics within SpaceMan are designed to turn complex masses of
information about a building into immediate insight. To print these graphics you need
a color printer - a HP 2000C is recommended. If you do not have one but would like
a color printout of the graphic, PlanData can produce it for you.

The Graphics pull-down menu offers the following commands:

Color Code Plan, Clear Color Codes, Building Pie Chart, Project Pie Chart, Floor Pie
Chart and Building Stack.

Color Code Plan
Color Code Plan allows you to decide how do you want to view your floor plan, and
how it will appear on printed documents. You may color-code any of the data that
resides on the database of your floor plans. For example, you can color code for Area
Types, Income, Lease Expiration, and Options.

Each type is assigned a range by default. For example: the rent color-coding may
start with SF increment of $0-$5/SF. These rent ranges may not be comparable to
your specific company allocations. The default settings may be changed for a realistic
allocation that your company uses.

To Setup your Color Codes:

1. Click on Utilities> Administration, located on the main menu bar.

2. Select the  button, from the

Administration dialogue box.

3. Select the Table Type you want to chang the ranges for. SpaceMan
is an intuitive program, which allows you to apply skills acquired
from one lesson to perform other similar tasks. For this objective
click on the the Rent Lookup table. Your screen will be similar to
the one shown.
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For this example you will change the Lower and Upper Values for rent SF
allocation, then choose a new color from the color palette. Begin by reviewing all the
values. Notice that increments are sequential and a change in one field will have an
affect on other fields. Only those fields of actual income will display on the legend
and color coded floor plan.

1. Click on a Lower value field. The number will highlight. Type in the
new range value.

2. Click on an Upper value field. The number will highlight. Type in the
new range value.

To change the legend colors, click on one of the color keys to the left of the
box. The palette will open where you can select a new color. Click OK.
Each of the fields in this dialogue box may be modified to your criteria.
Changes in the Rent Lookup table will affect the ccIncome legend.

Close all the dialogue boxes to return to the main drawing.

To Color Code Floor Plans:

To produce a color-coded floor plan: (spaces on the floor plan must be assigned
before using this feature.

Select Color Code Plan from the Graphics pull-down menu or click
on the Tri-colored  PlanData logo icon.

Select a category type, then click on the Ok button.

The drawing will color code and a legend will be created on the right hand side of the
screen.

To print the color-coded floor plan:

1. Select Print from the File pull-down menu or click on the print icon.

2. Send the drawing to the printer.

3. Click on the Print icon .

To Clear Color Codes:

This feature removes color-coding from drawing and returns you to command mode.
Undo color-coding by selecting clear color-code, or click on the clear color code
icon,  located on the main tool bar.
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Project Pie Chart
Creates a pie chart based on specified information for all properties within a project.

To create Charts:

SpaceMan can generate graphics based on either the floors of a building or all of the
buildings in a project. To create a graphical chart:

Select Project Pie Chart, Building Pie Chart or Building Stack from the
Graphics pull-down menu.

A list of predefined formats will display.

      Select the types of data you want to graphically represent then click the
OK button.

To Print the graph:

Select Print, and the Send Drawing dialogue box will appear. You can
add comments to your graph, and choose whether to send the drawing
to the printer or to a file.

Click on the Print button located on the Print form that appears on your
screen.

If you don't want to print the chart that you are viewing, select the Cancel button to
return to the floor plan Building Pie Chart

Building Stack
Creates a stacking diagram based on specified information regarding the current
building.

To create a Building Stack:

1. Select Graphics from the main menu bar.

2. Now select Building > Proportional Stack or Aligned Stack.
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 Reports
This feature is used to generate reports based on data in the database and display it
on screen or print out on printer.

SpaceMan allows you to print multiple reports at the same time eliminating the need
to view them individually.

Report on Current Drawing

The Report Tab:

Select Reports from the Main Menu bar, and click on Print Reports. (Or click on
the Reports icon.)

Click on the tab titled Report to select the type of the report that you want.

Notice that you can select one or more reports to print at once, by click on the box
next to them or selecting All.

The Selection Tab:

Click on the tab called Selection to choose which building, floor and unit you would
like the report to describe.  Note: Make sure that the highlight bar is on the desired
report when setting the selection criteria.

The Setup Tab:

Choose this tab to enter headers and footers for the report.

The Print Report button:

When you are finished setting up your reports, click on the Print Report button
located on the bottom of the Reports screen. Click preview to view the actual report,
before it is printed. Click on the print icon, located on the main tool bar of the Report
Preview screen.

Report on Project
Allows you to select the Reports and a destination you want to view them, from the
database.

Report on Portfolio
The Report Preview screen appears.  From this screen you can tell SpaceMan were to
send the report — a printer or a file. To send the output to a printer, click on the
printer icon.  To send the output to a file, click on the export icon.  To zoom in or out
of the document on the screen, click on the screen icon.
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Utilities
Allows uses to access various functions such as editing data directly in database
tables, finding records, working with area statistics, etc.

Find Records
Allows you to create and run basic queries, and then view that information with
graphically.

To work with the Find Records dialogue box:

1. Click on Utilities > Find Records from the menu bar.

2. Select the query options using the drop down arrows provide for each
box.

3. Click on the Add to List button. Your query will post to the Selection
List.

4. Click on the View Records button. The Results of query dialogue box
will open with your records.

• Select Find to enter a new query.

• Select Show on floor to see a color-coded representation of
the query.

• Select Close to exit the dialogue box.

Click the Clear Selection button to empty the list.

Click the Delete Item from List button to omit an entry.

Click the Close button to exit the dialogue box.

Edit Data Files
Opens the View Data Files dialogue box where you select the option to edit. Scroll
through the list and highlight the data field you want to edit. Click OK. Tab through
the fields to change the attributes.

View Area Statistics
Opens the Floor Area Statistics dialogue box. This dialogue box allows you to
change the attributes of calculations assigned to a building.

Measure Distance
This menu item will calculate the linear footage of a given line.

To Measure Distance:

1. Select Utilities from the menu bar.

2. Select Measure distance to view the cross hair cursor.
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3. Click on two points for a calculation of the linear footage.

4. Right click to end selection, and view the linear footage.

5. When finished click OK to clear the dialogue box from the screen.

Show Entity Layer
This menu selection allows you to click on an item within the floor plan to determine
its layer, and, as an option, hide that layer. To clear the drawing of unwanted fixtures,
columns, partitions, etc., and visually uncluttered your work, use the cross hair to
make your selection.

To undo selections, select View > Layer Manager, from the menu bar. Scroll
through the list on the Layer Manager menu and highlight the layer you want to
return. Click the Light bulb icon, and your item will return. Layer Manager is another
option to select view/hide for layers.

Explode Symbols
Break symbols down into basic graphic elements. If you are trying to use one of the
convert functions, and the function does not work properly it is probably because the
graphic element is a part of a symbol. Try issuing this command. Once symbols are
exploded, they will remain exploded until you exit and reload the file. While symbols
are exploded you won’t be able to use symbol insertion points in the drawing mode.

Shift Floor Plan
For various reasons, the SpaceMan file may shift away from the CAD file on a
drawing.

Delete CAD Entities
By selecting this command from the Utilities menu, you can delete what SpaceMan
displays of the CAD file.  However, this is temporary for the current session only.
SpaceMan does not make any changes to the CAD file at all.  If you find that there
are entities in your reference CAD files that you do not want displayed, please
contact your PlanData representative for solutions.

Check Drawing
Will open a pop-up, which informs you of all unassigned space and the square
footage.

Administration
SpaceMan gives administrators special privileges; usually these functions are located
in the Administrative section of the Utilities pull-down menu. This includes
working with look-up tables, queries, and giving permission for various users of the
system to perform specified activities. For a detailed description of these functions,
see Chapter 5: Administrative Functions.
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Help
Allows you to locate help on specific topics, as well as discloses general information
concerning your version of SpaceMan that you are running.

Contents
Opens the table of contents in a hierarchical order. Follow paths to the subject you
need information about.

Search for help on
Opens the Find setup wizard that will help you localize your search item.

Technical Support Request
If your company has purchased a technical support contract and you have questions
or encounter any problems with SpaceMan, you can help PlanData help you by filling
out a Technical Support Request form.  By using this form, we at PlanData are able
to process your request for help in a more efficient manner while providing you with
the best solution to your problem.  The Technical Support Request form also allows
you to provide PlanData with feedback for future product development.  Simply fax
or e-mail your problems and comments to us, using this form, and we will respond as
soon as possible.  To make it even easier for us to identify and fix your problem,
when the program asks you if you want to send your database, click Yes.

About SpaceMan
Tells you what version of SpaceMan you own, as well as how much free memory you
have left.
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Chapter 3 Icon Reference

Icon Descriptions
The main tool bar provides you with a selection of tools (icons) that allow you to
work efficiently. Place the cursor on an icon to view its description on the status bar.

Open; Opens the select file to open dialogue box where you can
view the files in the directory.

Save; Saves a drawing.

Print; the current file, report drawing or graph.

Print Reports; Choose the Report tab to select the options you want
to print. Chose the Selection tab to select the Building, floor and unit.
Use the Setup Tab to edit the report header.

Add boundary; Opens the Accuracy toolbar and allows you to add
a boundary to a SpaceMan drawing.

Delete boundary; Erase existing or new boundaries.

Assign space; Assigns a label to a space. Labels are your “link” to
the database.

Delete assignment; Deletes an assignment from a space.

Views data files; Gives you access to all the data tables.

Show area; Shows the area of the space you click on.

Recalculate areas; Re-Calculates Rentable Square Footage for a
floor.
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Zoom default; Returns the screen to the default view.

Zoom Window; Allows you to select a specific are of the drawing
with a selection tool.

Zoom in; Allows you to change the view of the selected area to a
larger scale.

Zoom out; Allows you to decrease the view to a smaller scale

Zoom Previous; Allows you to return to the previous view.

Redraw screen; Redraws the screen.

Color-code; Color-codes the drawing.

Clear color-code; Removes color coding mode.

Layer Manager; Allows the user to change which layers are displayed.

Show entity layer; Displays which layer of a selected line is on. It
also gives the user the option to hide layers.

View pictures; Views photographs that are associated with the
drawing.

Search database; Find Records.

Accuracy Tool Bar

Working with Boundaries
The accuracy toolbar allows you to work with either a SpaceMan file or a CAD file.
When you are ready to add a boundary click on Add Boundary from the Boundary
pull-down menu, or click on the Boundaries icon. SpaceMan will display the
accuracy tool bar. The tools on the Accuracy bar allow you to be precise in the
placement of boundaries for space allocation.
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SpaceMan Entities icon; This icon selection is one side of a toggle
that allows you to work with drawing entities (boundaries) created directly in
SpaceMan.

Reference File Entities; This icon selection is the other side of the
toggle that allows you to draw boundaries in geometric relationships to CAD
file entities. The reference file typically contains the base or core building,
such as exterior walls, columns, mullions, elevators (or other vertical
penetrations), lavatories, etc.

Show area; Click this icon to view Square footage allocation of an area.
You can view: Net area, adjusted area, and available rental space.

Free hand; Allows you to draw freehand lines.

Snap to line endpoint; Will position the new line on an existing
SpaceMan or CAD entity line.

Snap to midpoint; Will find center of an existing partition.

Snap online; Will end line at existing partition.

Snap to intersection; Will position the new line to intersecting lines.

Snap perpendicular to line; Will position a new line exactly 90
degrees to a selected entity.

 Snap to line center point; Select two parallel lines. SpaceMan will
add a centerline between them, and if extra length is specified, will
stretch it.
Snap to center; Will snap to the center of a circle or arch.

Symbol Origin; Snaps to origin (or intersection point) of a symbol (or
AutoCAD block.

Dimensional Offset; Allows you to select a point for a line using exact
dimensions in an X, Y plane.

Polar Offset; Allows you to select a point for a line using angular
dimensions.

Exit Drawing Mode; Will close the accuracy toolbar and returns you to
command mode.
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Accuracy Modes
Depending on the mode you select, SpaceMan or CAD, the tools on the Accuracy bar
will perform differently. The following table is a review of each tool in its
corresponding mode.

Mode Action with
Spaceman entities

Action with CAD
entities

Free Snaps to the selected point. Snaps to the selected point.

End Point Searches through all
Spaceman boundaries and
snaps to the closest
boundary end-point.

Searches through all CAD
file lines visible on screen
in current view and snaps
to the closest line end-
point.

Mid Point Searches through all
Spaceman boundaries and
snaps to the middle point
of closest boundary.

Searches through all CAD
file lines visible on screen
in current view and snaps
to the middle point of the
closest line.

On line Searches through all
Spaceman boundaries and
snaps to the closest point
of closest boundary (snap
point can be either
perpendicular projection
from selected point to the
closest line, or its end point
whichever is closer).

Searches through all CAD
file lines visible on screen
in current view and snaps
to the closest point of the
closest line (snap point can
be either perpendicular
projection from selected
point to the closest line, or
its end point, whichever is
closer).

Intersection Prompts you to select two
boundaries (which will be
chosen as closest to the
selected points). Calculates
intersection point and
snaps to it. If boundaries
are not parallel and do not
cross, intersection point is
calculated for their
extensions. If boundaries
are parallel, no snap is
done.

Prompts you to select two
lines in the drawing (which
will be chosen as lines
visible on screen in current
view and closest to the
selected points). Calculates
intersection point and
snaps to it. If lines are not
parallel and do not cross,
intersection point is
calculated for their
extensions. If lines are
parallel, no snap is done.

Perpendicular Searches through all
Spaceman boundaries and
snaps to the perpendicular
projection from selected
point to the closest
boundary.

Searches through all CAD
file lines visible of screen
in current view and snaps
to the perpendicular
projection from selected
point to the closest line.

Center line Prompts you to select two
boundaries (which will be
chosen as closest to the
selected point boundaries

Prompts you to select two
lines (which will be chosen
as closest to the selected
point lines visible on
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in the drawing). Calculates
perpendicular projections
from selected points, and
snaps to the point exactly
between projections.

screen in current view).
Calculates perpendicular
projections from selected
points, and snaps to the
point exactly between
projections.

Circle center None Selects closest circle
visible on screen in current
view and snaps to its
center.

Symbol origin None Selects closest symbol
visible on screen in current
view and snaps to its origin
(insertion point).

Dimensional offset Prompts you for horizontal
and vertical distance from
last entered point,
calculates resulting point
and snaps to it.

Prompts you for horizontal
and vertical distance from
last entered point,
calculates resulting point
and snaps to it.

Polar offset Prompts you for angle and
distance from last entered
point, calculates resulting
point and snaps to it.

Prompts you for angle and
distance from last entered
point, calculates resulting
point and snaps to it.
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Chapter 4 Delineating and
Assigning Space

Demising Space
This section will describe the features for sub-dividing space. With some of the more
advanced tools found in SpaceMan you can:

â Delineate Space

â Work with Layers

â Re-Demise Space

â Obtain Area Calculations for Space

â Specifying Information to be Displayed in Space

â Add, Edit or Delete Data

Delineating Spaces
A good tip for starting to delineate space is to start from the outside and work your
way in. In other words, start by delineating the overall space that you wish to measure
out (i.e. glass line, convector line, etc.) to establish gross square feet (SF). Once this
has been completed, you can begin sub-dividing space within.

Space is first delineated using SpaceMan drawing tools found on the Accuracy tool
bar. Once this is done properly, you can obtain square footage information. In order
for SpaceMan to be able to calculate square footage and color-code space, all
boundaries that delineate a space must be “closed”. In other words, the endpoints of
each boundary must touch other boundaries.

In SpaceMan you use these boundaries (or SpaceMan “smart” walls) to enclose an
area on the floor plan, such as a suite or common area. Then you assign a room label
and other attributes to the area. SpaceMan's approach to defining areas differs from
most other systems. The most common approach used by other systems is to add a
polygon around each area.

SpaceMan avoids the pitfalls of polygons by using a single line to define a common
boundary. These single lines or “smart walls” eliminate the possibility of open space
and/or overlap. In addition, SpaceMan uses “interference checking” when adding
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boundaries. This ensures that only one boundary will enclose a space, even if you
draw completely over another boundary.

This approach to space measurement is more accurate than using polygons, and it
also make it easy to subdivide a floor plan.  In addition, your SF for the floor will
always “box” to your Gross SF.

SpaceMan & CAD Reference Files
One of the key benefits of SpaceMan is its ability to take advantage of the accuracy
of CAD files. The way SpaceMan achieves this is by using CAD files as a
“reference” for which SpaceMan “Smart Walls” (Boundaries) are drawn. SpaceMan
can read the coordinates and lock into them for accuracy.

For example, SpaceMan will recognize the end point of a line even if it had been
drawn by a third party CAD system. Depending on how the CAD reference file is
developed, SpaceMan can even recognize elements such as insertion points of blocks
or symbols. This can be very useful if that block happens to be the center of a
window mullion.

In addition to these benefits, SpaceMan allows you to control what information is
displayed even if the information is stored on a CAD file layer.

Working with Layers
Every element drawn in a CAD drawing is assigned to a layer. Layers allow you to
keep different groups of objects separate within the same drawing. You can think of
layering as making a series of acetate overlays. For instance, base building walls,
dimensions, electrical and HVAC should all have their own layer within a CAD file
(as long as they were produced properly). Producing the drawing in this fashion
allows you to hide information not relevant to the current task.

Different boundaries are found on different layers and there are times when you may
want to toggle the display of certain boundaries. For example, you may want to turn
off all the interior office partitions on the floor for a prospective tenant. The tenant
could then plan partitions for division of space. Or perhaps you want to see what a
floor would look like without any of the demising walls so that you can quickly get a
better idea of the space potential available to a new full floor tenant. Whatever the
scenario, you have the ability with SpaceMan to toggle any Reference layer off or on.

Layer Manager:

The five icon buttons at the top of the box allow you to quickly and easily change
which layers you are viewing or working with:

â Display /Hide Layers

â Make a Layer “Current”

â Layer Properties

â Sort Layer List Alphabetically (or numerically)

â Select all Layer Items
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Re-Demising Spaces
Now we will begin re-demising space (as opposed to delineating space from
“scratch”) since:

Most SpaceMan users have PlanData pre-load properties for them.

There are essentially two ways that a user can re-demise space:

â Sub-Dividing a Space

â Combining Space

To Sub-Divide a Space: (adding a boundary)

In this example you will add a boundary partition to create a new space. You will
connect column lines to existing partitions in order to sub-divide a space. For this
example it is best to use the sample office space drawing [C:\SMW\OFFICE\GH3-
03.SM].

1. To begin Select Add Boundary from the Boundary pull-down menu
or click on the  Add boundary icon.

The Accuracy tool bar appears on your screen and you are ready to subdivide a
space.

2. Select the  Reference CAD File Entities icon from the tool bar. The

Reference icon allows you to connect to existing structures.

3. Click on the  Symbol Origin (block insertion point) icon.

4. Place cross-hair cursor  on a column located on an exterior wall
(use the Zoom in tool for a better view of an area), then click the left
mouse button.

As you move the cursor away from the column, observe the line that draws along
with it. This means that the starting point of a wall has been located.

5. Return to the accuracy tools and click on the  SpaceMan icon.

You must change modes of the drawing tool in order to attach the line to a corridor
wall.

6. Select the  perpendicular icon from the Accuracy tool bar. Using

the perpendicular command assures you the new wall will form a 90-
degree angle with the corridor.

7. Drag the line to a corridor wall, and then click on the wall.

8. Right click to quit drawing a line.

9. Move the cursor into the space you sub-divided and right-click.

Notice that the space will color-code blue (set by default) indicating that the space is
closed. If it does not color-code, repeat the process of adding boundaries until you
successfully close the space.

Note: If you decide not to create a wall after you have already selected a starting point, click the right
mouse button. The line dragging behind your cursor will disappear, and the wall will not be created.
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To Delete a boundary:

Deleting a wall is a simple procedure. In our example we are going to remove the
wall between suites 103 and 105 and name the entire area 103.

1. Select the Delete Boundary command from the Boundary pull-down
menu. Point the cursor (a target symbol) at the wall and click the left mouse
button.

 

2. Click the right mouse button to escape back into command mode.

Combining Spaces
Many times, users need to re-demise space by combining two or more spaces. This
couldn't be simpler in SpaceMan since you only need to delete the walls common to
both spaces, and then remove the assignment label(s) and create a single label for the
new space.

To Combine Space:

1. Click on the Delete boundary icon.

2. Place the cursor on the partition you want to delete and click.  The
existing CAD file partitions can not be deleted.

3. Right Click in the new space. The Edit Space Assignment dialogue box
will open where you will change the room number and other
information about the newly created space.

4. Click OK when you have finished altering the information.

Assigning a Space Label
In order for SpaceMan to be able to tie information to a space, the space must be
assigned a Space label.  Before we begin this, however, we should discuss how data
could affect the process of assigning space. For instance, if the occupancy data for
the space is based on the unique combination of Building, Floor and Room (space),
then you can enter this data while assigning the space label.  Alternatively, you might
have a unique combination of Building, Floor and Room so SpaceMan allows you to
tie a Lease ID to a space and all relevant information will be tied to this Lease ID.
You should note that, in the example of using a Lease ID, you can only view the data
- not edit it.

Another important aspect of assigning space labels is to know what types of space
that you’re going to be assigning.  For our purposes, we’ll be assigning a label for a
tenant space but labels can also be assigned to non-tenant spaces for the purpose of
calculating the rentable square footage of a floor and/or building.

To Assign a Space Label:

To assign a Space Label you must first sub-divide a space. Refer to the drawing

[C:\SMW\OFFICE\GH3-01.S_M]. Follow directions found in the section To Sub-
divide Space (adding a boundary) to continue with Assigning a Space Label.
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Upon completion of sub-division continue on to assign a Space Label.

1. Click on the  Assign space icon, or select

 Assignment > Add Assignment from the main menu.  Note that your
cursor changes to the hand and pencil icon

2. Click within the space that you want to assign a label to.

The Assign Space dialogue box will appear. Note that the Building Code and Floor
Code Fields are already filled in based on the building and floor that you are working
with. In the Old Area text box you will see the room number of the space you
divided.

3. Type in a new Space Code. Use the Old Area number and add an a Ex
306a. If you have a Lease Code to tie to the space, select it by clicking
on the drop-down list to display all the valid Lease ID’s in your
database or just type one in.

4. Select a Space Type from the drop-down list.

5. Select an Assignment Style from the drop-down list.

6. Type a Font size in the Size, in text box provided. Suggested 44pt.

7. Click OK. The Edit dialogue box will close, returning you to the
Assigned space. Your Label will appear in the new room.

You may return to the Edit box by clicking on the room label with the hand icon. All
assigned labels can be change using the Assign Space dialogue box. You can move
the position of the label by selecting Assignment > Move Assignment command from
the main menu.

To Remove a Space Label:

When you need to combine two rooms it is usually because a tenant has moved out
and another has taken over their space. This logically involves the removal of a wall,
but you must also remember that you must remove the old tenants room record as
well. If the record isn't removed, SpaceMan will include the record in its calculations.
Therefore, the tenant that vacated the space will still show up in the tenant rent roll,
the tenant that took over this vacant space will be under billed, and SpaceMan will
issue an error message until the matter is resolved. To remove a room record:

1. From the Assignments pull-down menu select the Delete Assignment
command.

 Notice your cursor changes into a target symbol.

2. Now place the cursor in the desired room; click the left mouse button.
A dialogue box will appear on your screen. Answer the prompts
appropriately.

Once you are done, SpaceMan automatically corrects the database and related rent
roll reports.



PlanData Systems Corp. Chapter 4 Delineating and Assigning Space  ••  42

Using Dimensional Offset
This tool allows you to type exact dimensions for placement of boundaries relative to
a specified point. That is, once the starting point is defined, the cursor can be moved
an exact distance from that point. This feature allows you to draw walls that bend or
step in and out.

Note: If you added the walls described in the previous sections, you may want to
delete them before beginning this example.

To Draw a Dimensional Offset:

Select Add Boundary from the Boundary pull down menu or click on the boundary
icon to open the Accuracy toolbar.

A Dimensional Offset box allows you to move right or left on an imaginary X-axis or
up and down on an imaginary Y-axis. The base reference point for a dimensional
offset will always be your selected starting point.

1. Place the cursor where you want the line to start as a point of reference.

2. Click to start the line.

3. Return to the Accuracy tool bar and select the  Dimensional Offset

icon. The Dimensional Offset dialogue box will appear, prompting you
to fill in the X and Y-axis dimensions in inches.

4. Type in the X-axis offset, (denote negative integers for left offset) in
inches.

5. Type in the Y-axis offset, (denote negative integers for downward
offset) in inches.

6. Click OK for the offsets to take effect.

Using Polar Offset
This tool is similar to the Dimensional offset tool, since it also allows you to specify
exact dimensions for placement of boundaries relative to a current starting point. The
difference is that Polar offset will allow you to specify angles for your partitions.
Rather then X and Y distances (as we did with dimensional offset), a partition can be
drawn any specified distance and angle away from the starting point of the wall.

Note:  Zero degree is straight along the X-axis moving to the right (positive) of the
current point. Ninety-degree is directly above (positive) the current point, along the
Y-axis. One hundred eighty-degree is straight along the X-axis moving to the left
(negative). Directly below the current point, along the Y-axis, are two hundred-
seventy degrees (negative).

To Draw a Polar Offset:

1. Place the cursor where you want the line to start as a point of reference.

2. Click to start the line.

3. Return to the Accuracy tool bar and select the Polar Offset icon .

The Polar Offset dialogue box will appear, prompting you to fill in the
Angle degrees and the Distance in inches.
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4. Click OK for the offsets to take effect.

Viewing Area Calculations
Upon completion of adding demising partitions, you will be able to view the
calculations of the new sub-divisions.

To View Space Calculations:

1. First, select the Assignments pull-down menu and select the Show
Area command.

2. Then place the cursor inside the new room and click the left mouse
button. A dialogue box will appear on your screen. As an alternative, right-
click while the cursor is situated in the space that you want to calculate the
area of. The data menu will appear on your screen, further information
(room number, and Net SF) can be found on the status bar, located at the
bottom of your screen.

3. Click on OK and the data menu will disappear.

Note:  If the room is not closed, SpaceMan can not calculate the area. If this occurs,
check all boundaries to insure they are closed. The Trace Boundary command was
designed to help you locate these problems.

If you want further details about the floor area and how it is calculated, click on
Utilities on the main menu and select View Area Statistics.

Specifying Information for Display in Spaces
You may decide at some point that you need the room labels to display different
information on the drawing. Notice that by default only the room numbers appear on
the drawing. However, SpaceMan can display various types of data along with the
room number. To change data you want to appear, you must specify the label style of
the assignment information.

To Change the label style:

1. Select Assignments > Edit Assignment from the main menu. The
cursor will change to the edit mode cursor.

2. Place the cursor on the desired space and click. The Edit Space
Assignment data screen will appear. Notice that sometimes the Space
Code begins with an asterisk. These assignments are system allocations
for tracking common and non-rentable areas, i.e. office buildings shafts,
corridors and restrooms.

3. Click on the down arrow next to the Assignment Style box.A drop
down box will appear, listing all of the styles available.

4. Select, for example, the Room/Tenant style from this box.

5. Click on OK to apply changes.

Now the room number and the name of the tenant will display in the drawing. In
some cases the ability to read this information is distorted by the font size. To change
the font size of the label:
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Go back into the Edit Space Assignment screen, and click on the Size item box. Enter
the new size in inches, and then click on the OK button to apply changes.

Editing All Assignments
When you click on Edit All Assignments from the Assignment pull-down menu, the
Global Edit box will appear. The Global Edit box is used to specify which
assignment information will be displayed for all of the spaces. To edit any of the
features located on the Global Edit screen, click on the radio button next to the
appropriate function.

Click on the radio button next to Include system assignments if you want to include
the assignment labels spaces whose ID begin with an asterisk. The asterisk signifies
an area considered a common area or non-rentable.

Note: When you change the assignment style, or activate the Include system
Assignments feature, you must specify the size that you want this information
displayed at.

To hide system assignments, click on the radio button and set the size for 0. All of the
labels will disappear. Now go back to the Global Edit screen, and select an
assignment style with a size you want the label to display.

Pop-up Menu
Right-click on assigned space to view pop-up menu. SpaceMan is design to add, edit
and modify records. For maximum user effectiveness the screens have been designed
to take advantage of look-up tables.

To Modify the Data Tables Associated with a Property:

1. Place your cursor in the space you want to work with.

2. Right-click in the space. To indicate the space is “closed” it will blue
color-code, while a data menu pop-up list appears.

3. Select from the list the specific information you want to modify.

4. Enter new data in the fields provided.

Working with Lease Option Data
SpaceMan gives you the ability to track which spaces are encumbered by lease
options.  To see if a space is encumbered by an option, simply move the cursor over
the space and, if it is encumbered, a red light will appear in the lower right hand
corner of the screen (in the Status Bar).  Another way of viewing encumbered spaces
is to color code your floor plan on options and any space that has option data
associated with it will be colored in.  At this point, you can move your cursor over
the space and the “bubble help” will display the type of option that space.
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If you’d like to see the option data associated with a space, simply right click while
your cursor is over that space and the pop-up menu will show “Options - “ and the
number of options that are associated with that space.  If you select “Options” from
that pop-up menu, you will see a list of options that area connected to this space.
Under “Option Code” you will see the type of option associated with this space (i.e.
ROFR = Right of First Refusal or CANCEL for a cancellation option on the space)
along with the effective date of the option.  You can display the specific data for each
option by selecting it on this list.  The specific data that would be displayed is to the
right of this options list box and includes who the holder is of the option, the type of
option (based on the look up table which your SpaceMan administrator has setup (see
Administrative Functions), the notice date for the option, the effective date for the
option and who is responsible to send the notification.  In addition, there is a memo
field provided for more descriptive copy of this option.

You may wish to view more details about other spaces that might be affected by this
option.  This can be accomplished by clicking on the “Details” button at the bottom
of this pop-up screen. Displayed will be a list of spaces that are affected by this
particular option.  For instance, an option can be on every space in a building, any
space on a floor, or on a specific space.

Editing Option Data
To edit option data, simply click on the Edit button at the bottom of the pop-up
screen and edit the data you wish to change.  Included in editing this data might be to
change which spaces are effected by a given option.

Adding Option Data
To add an option to a space, click on the Add new button at the bottom of the pop-up
screen.  Select the Option Holder from the pull-down list of tenants by clicking on
the down arrow.  Likewise, select the type of option that you would like to add by
choosing from the appropriate choices provided.  Finally, select which spaces are
effected by the option. Note that entering a * in any field in the ”Affected Spaces”
data grid will ensure that this new option will be for all cases in the appropriate
columns.  For example, entering a * in the Building Column will apply this option to
any building in your database, an * in the Floor column will add an option to any
floor in the designated Building column, and an * in the Room column will apply this
option to any space on the floor in the designated Floor column.
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Deleting Option Data

To delete option data, click on the option that you wish to delete in the Option Code
listing. When the option is selected (highlighted), click on the Delete button at the
bottom of the pop-up screen.  A warning will appear making sure that you really
want to delete this option record.  Clicking on “Yes” will delete the option while
clicking on “No” will return the option pop-up screen.

Assigning an Option to a Tenant
Note: Only users with permission to administrate/modify data can add, delete, or
update option information. All other users have permission to read-only information.

Once option types are setup by the Administrator, you may select a type then assign
it to a tenant (lease). Locate the tenant whom you want to assign options (e.g. room
100 on the first floor of Office demo project) and right-click. Select Options from the
popup menu. The Add New Options form will appear on the screen. If no options
are designated, the form will have no data. Click on Add new and enter the required
information. Make sure you provide the information on what space this option
affects. In the example case only the occupied room is effected, therefore only one
line in the  “Affected spaces” field is written in. Click the Save button to store your
data:

Once Options are added, you may view their details with use of the options form.
Just click on the desired option in the upper left list of options, and the option
information will show up. You can click the Details button to display the list of
rooms affected by this option.

Example 2: The right of first offer (ROFO) option, gives the tenant right of first offer
on any available space on the first floor. Enter the * (asterisk) in the Room column
field of “Affected spaces”, to signify all space on the first floor is affected by this
option.

If there were assigned options for all the space in the building, you would enter an
asterisk in both the Floor and Room columns. Currently SpaceMan does not allow
you to specify an option affecting all rooms in multiple buildings of a project
(placing an asterisk in the Building column, is an invalid value).

Making A Record “Current”
A fundamental concept associated with editing or deleting records in a database is
that the record must be current to modify it. To tab through the records you can use
the Next, Previous, First and Last buttons.

REMEMBER: The current record display on screen will be effected by the editing
action made.
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Adding a Record
Once you have created a space and assigned identification, you should add a record
to this space on the database.

To Add a Record:

1. Place the cursor on the newly created space.

2. Right-click your mouse button.

3. Click the left mouse button, on the selection Spaces.

A dialogue box will appear which questions you, “Do you want to add a new
record?”

4. Click the Yes button

5. A data table titled Spaces will appear on your screen at this time.

6. Type in the new data.

7. Click on OK, and the data will be saved into the database.

To disregard changes click on Cancel Changes and Close.

To Edit a Record:

When the appropriate record is “current,” you can edit any field by clicking in the
space provided. Type the new data to overwrite existing data in the field.

To edit room data:

Place the cursor in a room that you want to change and right-click. The Data table
will pop-up.

Select the attribute you want to modify.

SpaceMan will provide you with a data table to enter in the new data. To return to the
drawing select the Ok button.

To cancel, select the Cancel Changes or Close button (depending which is offered
on the table).
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Chapter 5 Administrative
Functions

Modify Rights
This section, will work with the data available to administrators with rights to modify
the program.

â Create a Customized Label

â Work With Look-Up Tables

â Add Tables to the Data Menu

â Create a Query

â Add New Reports to SpaceMan

â Importing Data

â Define User Privileges

â Command Line Parameters

Create a Customized Label
SpaceMan allows you to customize and add new label styles for your project.

Select Edit Assignment from the Assignment pull-down menu, and click on a space
for the  label style you’d like to change. Or, point to the area of the floor plan that
you want to edit the assignments of, click the right mouse button, and select
Assignment from the data menu.

To add a customized label to the list:

1. Click on the Edit Style button located on the Edit Space
Assignment dialogue box. The Space type dialogue box will
appear.

2. Click on the New button.

3. Type in the Style Name.
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4. Select a Database Field from the drop-down list provided.

5. Drag the folder icon to an Assignment line.

6. Select a Background type. To fill color, make a selection from the
palette.

7. Click the Save button.

To edit a customized label:

1. Click on the Assignment Style that you want to change and then
click on the Edit Style button.

2. When the Assignment Style form appears on your screen, click on
Edit.

3. Click on the Clear button at the end of the assignment line that you
want to change.

To add database information:

1. Select a database.

2. Select the type of information (field) that you want to display.
Highlighting your selection, then drag the table icon to the first blank
line under the heading Assignment Lines.

To add text:

1. Add comments to your assignment information by typing in your
comment, then drag the text comment icon to the first blank assignment
line.

Labels may contain up to five lines of information, which are retrieved from the
database.

To save your customized label, click on Save. Click on Cancel to return to the Edit
Space Assignment form without saving your changes.

To add a hatch:

1. Click on Edit.

2. On the right side of the screen is a display of all the background
patterns you may select. Click on the radio button next to the hatch style
that you prefer.

3. Click on Save.

Working with Look-Up Tables
All the data in the system is
connected based on common
relations to each other.

PlanData's SpaceMan is a built around a relational database system. In order to keep
structural integrity and to maintain ease of use, certain “codes” are established. Most
of these are transparent to you but when they are not, PlanData has created “look-
ups” which list all the valid choices.

SpaceMan uses two types of look-up tables, a Name Value look-up and Range look-
up. The Name value look-up is used for alphanumeric data such as space type codes
or business type codes. Range tables are used for numeric or date information, such
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as rent per square foot or lease expiration dates. Use range to group together
information on a graphic and/or report.

Within SpaceMan, look-up tables serve two functions. They are used to validate data
entered into the system for exact match look-ups, and they are used to define a model
for creating color coded graphics.

Overlapping Range Value Tables

When working with range tables, be careful not to overlap values. In the following
example, a value of 80 would match record 1 and 2.

 
 

 Record #
 

 Lower
 

 Upper
 

 1
 

 0
 

 100
 

 2
 

 75
 

 150

Name Value Tables
The layout of a name value table is as follows:

 
 
 Field Name

 
 Field Type

 
 Code

 
 Text8

 
 Name

 
 Text32

 
 Sort order

 
 Number

 
 Force_To_Legend

 
 Text1

 
 Fg_color

 
 Number

Range Tables
Range tables work in a similar fashion to Name Value tables. The layout of a range
table is as follows:

 
 

 Field Name
 

 Field Type
 

 Lower
 

 Number or Date
 

 Upper
 

 Number or Date
 

 Name
 

 Text
 

 Sortorder
 

 Number
 

 Force_To_Legend
 

 Text
 

 Fg_color
 

 Number
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To Add a Look-Up Table:

Administrators reserve the right to create look-up tables in order to customize
SpaceMan to fit their needs.

1. Click on Administration from the Utilities pull-down menu.

2. Click on Add Look-Up Table, and an input screen appears.

3. Type in the name of the look-up table that you want to create, the type
of table it is, and click on Add. If you decide not to make a look-up
table, click on Cancel.

 

A dialogue box will appear on your screen, asking you if you want to add values to
your look-up table.

4. Click on Yes.

Note: Now you are editing the look-up table that you have created. To edit a look-up
table, simply click on the cell that you want to change and type in the new
information.

To Edit Look-Up Tables:

In order to edit a look-up table:

1. Select the following commands in sequence: Utilities -
Administration.Click on Edit Look-Up Table.

Only those tables which are defined as LOOKUP in the table SMANTBLS will be
listed. To change values in the table click in the cell and type in the value. Data will
be updated as soon as the cursor leaves the cell.

To add a new record:

Go to the last empty row and start typing data in there. To delete a record, or
selection of records, click on the record selector (in the leftmost column). Now
select/deselect records, then hit the Delete key on the keyboard.

To sort data by one of the fields in the table:

Click on the column header of the column you want to sort by. For example, you may
want to select records by the SortOrder field to see the sequence of colors in the
legend when you color code drawing.

To change colors assigned to each record:

Type in the number of the color directly into the data grid (valid color number range
from 0 to 255). As soon as the cursor leaves the cell, with the new color number, a
corresponding tab on the right side will respectively change its color. Another,  more
visual way to do this, is to double-click the color tab and then select color from the
available list.

1. Click on the color box at the right of the field that you want to edit .

For this example, click on the color to the right of the row labeled Available. This
will bring up the Color Fill Editor.

2. Click on the color that you want to change the color to, and then click
on Save. To exit without changing the color, click on Cancel.
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Add Tables to the Data Menu
When you select a space by clicking the right mouse button, SpaceMan creates the
data menu. The data tables available come from the SMANTBLS table, located in the
SpaceMan Access database.

To add a table to this list:

1. Click on Edit Data Files from the Utilities pull-down menu.

2. Select SMANTBLS from the list box that appears.

3. Scroll to the bottom of the list and add a new record with the TblName,
TblType and BFRkeylen.

TblName is the name of the table that you previously added to SpaceMan.MDB.
TblType describes the type of table. Valid choices are: IMPORT, BLDG, FLR,
UNIT, LOOKUP, REPORT, SYSTEM and MASTER. BRFkeylen describes the
number of fields in the primary index. For SpaceMan to link data to a space on the
screen, the BFRkeylen key must be at least 3. This tells SpaceMan that the file is
indexed on “Building, Floor and Room”.

Working with Queries
Microsoft Access queries are used to define how the drawings are to be color-coded
and what appears in the legend. There are two types of queries. The first type will
return information on a room by room basis, which is used for floor plans and
stacking diagrams. The second type, which is used for Pie Charts totals the area for
each category in the lookup table.

To create a new Query

1. Click on the Add Query button, located on the Administration form.
The Add New Query screen will appear.

2. Enter the query name, and select a query type.

3. Enter a description of the query in SQL (Structured Query Language)
terms.

You can do this manually by typing the SQL definition on the screen, or by loading it
from a disk file using the load button. Note: To produce a Query for color coding
drawings each field must be prefaced by “cc”.

4. Select the Check button, and the query will be verified.

If no errors are found, the query will be executed, and qualifying records
will be displayed on the screen. If query definition fails, an error message
will display.

5. Select Save to add the query to the database, or Cancel to close the
form and exit.
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Adding New Reports to SpaceMan Working with Queries
PlanData offers custom report writing as one of its many services. However, if you
choose to write your own reports you can use any report writer that works with
Microsoft Access. PlanData uses Crystal Reports distributed by Seagate Software.
However, the software is not included with SpaceMan. SpaceMan uses a run-time
version only. If you are interested in purchasing a full version of Crystal, contact the
address below to see where your closest retailer is located.

To Purchase Seagate Report Writer software:
Seagate Software

1095 West Pender Street

4th Floor

Vancouver, BC  Canada V6E 2MG

Tel:      (604)681-3435

Fax:      (604)681-2934

Website:    http://www.img.seagatesoftware.com

Linking the New Report to SpaceMan
1. Once you have created a report with Crystal Reports, you need to copy
it into your Report directory (specified in Setup/Directories/Reports).

2. Then start up SpaceMan and open a drawing in the project that you
want to work on.

3. Select Utilities - Edit Data Files - Reports.
 

The Access table that is presented is used to communicate between SpaceMan and
Crystal Reports.

4. Go to the bottom of the table and add a new record with a description of
the report in the first column, entitled “Report Name”.

5. Type the report’s file name in the second column, entitled “Report
File”.

The rest of the fields can be edited interactively from SpaceMan during run-time.
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Importing Data into SpaceMan
Before you begin this section it is important to note that you can not import data
when a project is open.

To Import

Start SpaceMan < click on Cancel in the Select File to Open dialogue box
You should be left with a blank SpaceMan screen
From the menu bar select File < Utilities < Import Data

In order for SpaceMan to display the most accurate and timely information,
SpaceMan allows you to import data from other sources (i.e. from your property
management accounting systems, etc.).  For maximum flexibility, SpaceMan has
many different methods for importing data, which varies based on the source and
type of data that you plan on importing.  Following is a quick list of the different
methods for importing data, after that are some examples of each along with more
detailed descriptions for producing each.

Import Data Types

PlanData Import File (.PDI)

This is a file format designed to directly map fields import file fields to
corresponding SpaceMan fields.

Comma Delimited Text File (*.txt)

This is one of the most standard methods of transferring data between different
applications.  The file consists of one line per record with a comma separating field
values.

MRI Import File

This is a file that is generated from a property management accounting system called
MRI (Management Reports Inc.)

Access Table/Query

This method is for importing a Microsoft Access table into SpaceMan.  This can be
an existing table or the “Answer Table” to a Microsoft Access query.

Paradox 4.x Table

Tables in InPrise’s Paradox database format.

dBase IV Table

Tables in InPrise’s dBase format.
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Import Data Options
For any of the different methods described above, there are options that the use can
apply at time of import.  These options allow you to decide, based on the source of
your data, whether or not you want to append records to an existing SpaceMan
database, overwrite them, update them, etc.  These options are as follows:

Add new records, update existing records

By choosing this option, the user will be updating existing records with information
contained in the import.  If a particular record does not exist in the SpaceMan
database, it will be added during import.

Add new records only

This option will ignore any information in the import file if a corresponding record
exists in the SpaceMan database but will add records where there are no
corresponding records in the SpaceMan database.

Update existing records only

The import program will only update SpaceMan records where there are
corresponding records in the import file.  It will ignore import file records that do not
have corresponding records in the SpaceMan database.

Delete all existing records, then add new records

Obviously, this is the most dramatic option that can be selected.  This option will
wipe out all SpaceMan database records for the selected location in the SpaceMan
database (see next section) and replace it with the records contained in the import
file.  This option is used mainly when you are performing periodic updates to your
SpaceMan database (i.e. when accounting “books” data and it is ready for import
into SpaceMan.
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Selecting the Source, Destination & Import Model
When importing data, you obviously need to specify the file that you are going to
import, and the corresponding SpaceMan file that you want to populate based on this
import file.  You can also specify a “model” from which SpaceMan will import.
More descriptions are as follows:

File to import from

Select the file that contains the data to be imported into SpaceMan.  You can use the
“browsing” tool (…) provided to search your network drives for the location of this
file.

Database to import to

Select the SpaceMan database location that to which you want to import data to.  As
in above, you can use the “browsing” tool (…) to choose the SpaceMan database.

Import Table / Model

Choose a table or a model from a list of valid choices, which will be used as a basis
for this import.  When performing an import, you should know the type of data that is
contained (i.e. whether the information is lease-related data, option-related data or
store performance data, etc.) before you perform the import.

Advanced Import Functions
Once you have selected a type, option, source, destination and table/model, you may
or may not see the “Advanced” button become undithered (depending on the
combination that you choose, “Advanced” may or may not be a valid choice).  For
each field in the source (SpaceMan) table, the user choose to have certain data
modified on import based on the following:

Default value

In the event that a particular field is blank (or null) a value entered into this column
will replace the corresponding null value.

Suppress Leading ‘0’

Selecting this option will strip out any 0’s that precede a given value.  This is used
most frequently when the import data contains “leading 0’s” for floor or room
numbers where the corresponding SpaceMan records do not contain similar “leading
0’s”.

Import
When all the selections are made for your import, simply click on the “Import”
button to execute the actual import of data.  Depending on the quality of your import
file and/or the quality of data in the import file, you may or may not encounter some
error messages and/or warnings during the import procedure.  Be sure to read the
message carefully and select the option that you feel best reflects your requirements
for this import keeping in mind that you will have the option at the end of this
process to save or not save your import.  Keep in mind that there are some conditions
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that may cause your import to fail immediately.  Please refer to the following section
of the documentation for some guidelines on creating your import file.

Creating SpaceMan Import Files
The following section is a guideline that you can use in producing a file for later
import into SpaceMan.  To get started, first, you must determine which of two
methods for tying data to your floor plans:

Method: By a unique combination of Building / Floor / Room

This is the option that is the easiest to implement and maintain but can only be used if
you are confident that your external source of data has valid room numbers entered
into it and that they are maintained consistently.

This is a good alternative in case you are not maintaining accurate room numbers in
your external database.

After you determine which method to use, there are several ways of bringing external
data into Spaceman database, which are based on the following:

Using regular ASCII text files with comma-separated values
(CSV).

The advantage of this method is that CSV files can be easily generated by many
standard software packages, i.e. MS Excel, Lotus 123, etc. Using this method a user
creates a separate file for each table in the SpaceMan database which he/she wants to
update. The update routine in Spaceman must be executed for each table you wish to
populate.

Structure of comma-separated value (CSV) import files:

1st line:

Field names separated by commas.

To import data without integrity violations, EITHER first three fields in the import
file must be SM_BCODE, SM_FCODE, SM_RCODE (building, floor, room codes)
in this order when importing to Building/Floor/Room indexed table, OR first two
fields must be LeaseCode and BuildingCode when importing to LeaseCode indexed
table.

2nd and following lines:

Records with comma delimited data. The following rules apply:

  - fields must be separated with commas

  - text must be enclosed in double quotes (e.g. "123 MAIN STREET")
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  - Dates must be entered in the MM/DD/YYYY format, e.g. 06/21/1997, or in
MM/DD/YY format, e.g. 06/21/97. Four digits in the year portion are preferred
because of the Year 2000 issues, for they do not create ambiguities. If year is
presented with 2 digits, SpaceMan will use a user-defined “century window” for
interpreting these dates.

The combination of building, floor, room codes or LeaseCode should uniquely
identify each record (e.g. no two records in the import file may have building code
"ABC", floor code "01", room code "100"). Maximum length of building code is 6
characters, floor code is 3 characters, room code is 8 characters, and LeaseCode is 12
characters. Please refer to the file specifications at the end of this document.
Following is a partial example of data file, which will be properly read by SpaceMan
(building/floor/room based):

SM_BCODE, SM_FCODE, SM_RCODE, LeaseArea, Tenant, Contact, Phone, StartDate, EndDate, Rent, Rent_SF
"005001","1","00100", 343.00, "ORIGINAL C","", "",05/01/1989,12/31/2009,"", "", "", "",""
"005001","1","00101", 7095.00, "LANE BRYAN","", "",06/13/1989,12/31/1999,"", "", "", "",""
"005001","1","00102", 1959.00, "SPENCER GI","", "",10/22/1989,01/31/1998,"", "", "", "",""
"005001","1","00103", 1424.00, "KAY JEWELE","", "",07/24/1989,12/31/1997,"", "", "", "",""
"005001","1","00104", 1959.00, "NORTHERN STAR","", "",07/01/1989,01/31/2004,"", "", "", "",""

Or, for Lease ID based data, the file will look like
LeaseCode, BuildingCode, Tenant, Contact, Phone, StartDate, EndDate, Rent, Rent_SF, TOT_RENT, TOT_REN
"LG-123",  "005001", "ORIGINAL C","", "",05/01/1989,12/31/2009,"", "", "", "",""
"MN-678",  "005001", "LANE BRYAN","", "",06/13/1989,12/31/1999,"", "", "", "",""
"ED-543",  "005001", "SPENCER GI","", "",10/22/1989,01/31/1998,"", "", "", "",""
"WE-501",  "005001", "KAY JEWELE","", "",07/24/1989,12/31/1997,"", "", "", "",""
"WE-091",  "005001", "NORTHERN STAR","", "",07/01/1989,01/31/2004,"", "", "", "",""

Building/floor/room based file with data on Stores:
SM_BCODE,SM_FCODE,SM_RCODE,BUSST,SALES,SALES_SF,SALES_PC_CHANGE,BREAKPOINT,BREAKPOINT_SF
"005001", "1", "F-1", "SPE", 821774.69, 365.00, -2.4, 788003.13, 350.00
"005001", "1", "G-10", "FSV", 750561.67, 310.00, -12.4, 847408.33, 350.00
"005001", "1", "G-11", "WMC", 1399171.67, 420.00, -2.4, 1332544.44,    380.00
"005001", "1", "G-12", "WMC", 543537.78, 320.00, -20.3, 594494.44, 350.00
"005001", "1", "G-13", "VAC", 0.00,        0.00, 0, 0.00,         0.00

Or, for Lease ID based database, the same data will look like this:
LeaseCode,BuildingCode,FRONTAGE,BUSST,SALES,SALES_SF,SALES_PC_CHANGE,BREAKPOINT,BREAKPOINT_SF
"LG-123", "005001",   34, "SPE", 821774.69, 365.00, -2.4, 788003.13, 350.00
"MN-678", "005001", 24, "FSV", 750561.67, 310.00, -12.4, 847408.33, 350.00
"ED-543", "005001", 43, "WMC", 1399171.67, 420.00, -2.4, 1332544.44,    380.00
"WE-501", "005001", 21, "WMC", 543537.78, 320.00, -20.3, 594494.44, 350.00
"WE-091", "005001", 20, "VAC", 0.00,        0.00, 0, 0.00,         0.00

Using  PlanData Import (PDI) files:

The most flexible way to import data into SpaceMan is to use PDI files. The data
from a single PDI file (which is still a plain ASCII text file, but fixed length) can be
imported into one or more SpaceMan tables in one pass. The structure of PDI file is
the following:

Any number of lines at the beginning -

Comments (see example)

Following lines -
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Fixed length records (see example)

Example of PDI file (notice that fields have fixed length):
All Operating Properties
As of 05/31/97
111107     ,   1, 1187,DANSKIN/ROUND THE CLOCK       , 10/05/1993,  6/30/1998,   14244.00,  12.00
111108     ,   1, 1206,VITAMIN WORLD                 ,  6/23/1996,  6/30/1998,   17487.00,  14.50
111109     ,   1, 3708,CORBIN FACTORY STORES         ,  6/18/1990,  9/30/1998,   61182.00,  16.50
111111     ,   1, 7500,BASS COMPANY STORE            ,  6/07/1993,  6/30/1998,   97500.00,  13.00
111114     ,   1, 3072,GEOFFREY BEENE                ,  6/07/1993,  8/31/1998,   36864.00,  12.00
111207     ,   1, 2045,KASPER                        ,  1/01/1994, 11/30/1999,   32720.04,  16.00

In this example first 2 lines are comments to the data to help user to identify data by
looking at it. SpaceMan will ignore comments during import.

To setup SpaceMan to properly read PDI file user has to enter necessary mapping
information in PDI_MODEL and PDI_DETALS tables in destination
SPACEMAN.MDB. As soon as user chooses to import PDI file and select the
destination SPACEMAN.MDB, he is presented a list of import models from
PDIMODEL table. PDI_MODEL describes the import model and number of header
lines before actual data:

ModelID ModelName NumberOfHeaderLines

1 Import from MRI system 2

2 Import from SkyLine system 2

3 Excel data import 2

Table PDI_DETAILS describes selected model and data mapping to fields in tables:
ModelID TableName FieldNo FieldName StartPos Length Calculation

1 Leases 1 LeaseCode 1 12

1 Leases 2 BuildingCode 13 4

1 Leases 3 Tenant 24 30

1 Leases 8 StartDate 55 10

1 Leases 10 EndDate 67 10

1 Leases 11 RENT 79 11

1 Leases 12 RENT_SF 91 7

1 StoreData 1 LeaseCode 1 12

1 StoreData 2 BuildingCode 13 4

1 StoreData 3 BUSST 163 3

1 StoreData 4 SALES 167 10

1 StoreData 5 SALES_SF 202 8

1 StoreData 8 SALES_PC_CHANGE 211 8

1 StoreData 9 BREAKPOINT 141 11

1 StoreData 10 BREAKPOINT_SF 153 8

Default Structure of table LEASES

Table: Leases (Building/Floor/Room Method)
Field Name Type Size
SM_BCODE Text 6
SM_FCODE Text 3
SM_RCODE Text 8
Tenant Text 32
Contact Text 32
Phone Text 32
SIC Text 6
LeaseArea Double
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StartDate Date
EndDate Date
RENT Currency
RENT_SF Currency
TOT_RENT Currency
TOT_RENT_SF Currency
Note Text 8

Table: StoreData: (Building/Floor/Room Method)
Field Name Type Size
SM_BCODE Text 6
SM_FCODE Text 3
SM_RCODE Text 8
BUSST Text 8
SALES Currency
Phone Text 32
SIC Text 6
SALES_SF Currency
PROJ_SALES Currency
PROJ_SALES_SF Currency
SALES_PC_CHANGE Double
BREAKPOINT Currency
BREAKPOINT_SF Currency
SALES_TO_BREAKPOINT Double
OCCUPANCY_COST Double
Note Text 80

Table: Leases (LeaseID Method)
Field Name Type Size
LeaseCode Text 12
BuildingCode Text 6
Tenant Text 32
Contact Text 32
Phone Text 32
SIC Text 6
LeaseArea Double
StartDate Date
EndDate Date
RENT Currency
RENT_SF Currency
TOT_RENT Currency
TOT_RENT_SF Currency
Note Text 80
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Table: StoreData: (LeaseID Method)
Field Name Type Size
LeaseCode Text 12
BuildingCode Text 6
BUSST Text 8
SALES Currency
Phone Text 32
SIC Text 6
SALES_SF Currency
PROJ_SALES Currency
PROJ_SALES_SF Currency
SALES_PC_CHANGE Double
BREAKPOINT Currency
BREAKPOINT_SF Currency
SALES_TO_BREAKPOINT Double
OCCUPANCY_COST Double
Note Text 80

Table: BUSTYPE: (LeaseID Method)

This table is used as a lookup to the BUSST field in the StoreData table and defined
the Merchandising Categories.  It is highly recommended that this table be populated
with general categories so that the graphic is too many details to make it effective.

Field Name Type Size
Code Text 8
Name Text 32

Defining User Privileges/Administrative Rights
Click on the Administrative selection on the Utilities pull-down menu. The
Administrative form will appear; select Users from the options available. Within this
dialogue box you can add or delete users from the system and assign privileges they
can receive. When you are complete select Close to return to the Administration
form. The changes made here are automatically saved.

SpaceMan Editions
SpaceMan editions are set by a serial number, which determines the functionality of
the program.

SpaceMan; has all groups of users, including Administrative Rights that allows the
program to be modified.

SpaceMan/Broker; is a view only edition for a Broker, without Administrator
rights.

Demo has “Broker” rights, but can not save anything; limited to Office, Retail and
Proto projects.
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User Groups and their Recommended Access Rights

Group Administrate Modify Data Create Scenarios View Data

Administrator Y Y Y Y

Modifier N Y Y Y

Broker N N Y Y

Viewer N N N Y

Access Rights Description

View
Can “View”, zoom in and out, color code, prints floor plans; view data in database;
run and print reports. Can not change data; can not change space assignment; can not
save any changes.

Create Scenarios
All “View” rights; can create scenarios from master database. In those scenarios, you
can draw and assign spaces. You can not change data in master database or save
scenarios back to master database.

Modify Data
All rights except rights of an Administrator.

Administrate
Can assign rights to users, create database tables and queries, and change data in all
tables.

Command Line Parameters
It is possible to pass certain parameters to SpaceMan from the command line. The
name of a data file to load can be supplied, as well as user's ID and password. This
feature helps you to get to data faster by passing the login and file selection
processes, and it also makes it easier to link SpaceMan to third-party software
products.

SpaceMan can be called with the following parameters in command line:

C:\SMW\SMANW32.EXE [/fnFILENAME] [/uUSERID /pPASSWORD]

Open SpaceMan files from the command line.
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Enter /fn along with the path of a Spaceman file and the filename will start spaceman
and automatically open the specified file. Enter the full file name and path of a
SpaceMan data file. If it is specified in the command line, the program will try to
load it automatically when it starts. If the file could not be found, the program will
prompt you to select another location

User ID & Password

If specified, the program will bypass the login screen and perform checking on
supplied ID and password. If they are invalid, you will be prompted to enter ID and
password again.

To run SpaceMan with regular login and file selection:

C:\smw\smanw32.exe

To automatically load a file and go through regular login process:

C:\smw\smanw32.exe /fnC:\SMW\OFFICE\GH3-01.S_M

To login as "AFB" with password "QWERTY" and select file from the prompt:

C:\smw\smanw32.exe /uAFB /pQWERTY

To automatically load a file and login as user "AFB" with password "QWERTY":

C:\smw\smanw32.exe /fnC:\SMW\OFFICE\GH3-01.S_M /uAFB /pQWERTY

To work in the citrix  environment you must have /citrix in the command line.

 Instead of using the application path \temp folder for temporary files. The /citrix
command line parameter will store temporary files in the application
path\temp_XXXXX, where XXXX is the user ID.

C:\smw\smanw32.exe /citrix

To modify the location of the temporary folder SpaceMan uses with citrix during it's
normal operation the user can add a drive letter and path after the /citrix, for example
/citrixZ:\TEMPFILES.

To override the stored directory for the location of SpaceMan projects:

C:\smw\smanw32.exe /oZ:\NWREGION\SMW

NOTE:  beware of leaving 2 spaces between parameters.  It may cause
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Chapter 6 Calculating Rental
Space Availability

Introduction to Calculating Rental Space Availability
This chapter covers:

Defining Area Calculations

Selecting a Methodology for Calculating Rentable Areas

Where to Start Calculation Rentable Area

Calculating the Rentable Area by Type of Space

Alternative Methods of Calculating the Rentable Area

When computing the rentable area of a tenant's space, it is important to differentiate
between usable and rentable space. The most prevalent definitions for these terms
are:

Term Definition

Usable Area The demised area a tenant occupies.

Rentable Area The actual area a tenant will be charged for in
a lease.

The rationale behind Rentable Area is that while the tenant may only be occupying a
certain section of a floor, they are using and/or benefiting from other amenities that
are located on that floor or in that building (such as bathrooms, elevator lobbies,
mechanical spaces, etc.). The tenants should share the square footage of these
amenities. Therefore, the rentable area is the tenant usable space plus a proportionate
share of the floor and common building spaces. SpaceMan doesn't take a position on
how areas are calculated. Instead, SpaceMan provides the tools to easily allocate
these common spaces and generate rentable areas in a consistent manner.

A Word About Accuracy
Before we begin the mechanics of how SpaceMan calculates rentable area, please
review the warning regarding accuracy.
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In SpaceMan, the drawings can be considered to be scaled area models of buildings.
The CAD file (or reference file as it is called in SpaceMan) is the computer model
that SpaceMan uses as its source for architectural information. Since SpaceMan
allows you to lock into the geometry of the underlying CAD file (and, in essence,
traces over the drawing) it is the accuracy of this underlying CAD file that controls
the accuracy of the area calculations. Do not presume a CAD file is accurate
without checking on how it was created. We recommend that you find out who
created the file and verify the accuracy of the file. For this reason, PlanData’s
SpaceMan software can in no way be held responsible for errors resulting from
inaccuracies in the underlying CAD file.

Add Factor vs. Loss Factor
The add (or load) factor is the percentage added to a tenant's usable area to calculate
the rentable area. A loss factor is the percentage of a tenant’s rentable area, which is
lost.

Methods of Calculating the Rentable Area
There is more then one methodology to use in calculating the Rentable Area of a
building. There are many variables to consider when developing any methodology for
example, sometimes the variable is the local market that is the deciding factor. Many
organizations use The Building Owners and Managers Association's Standard, for
office buildings as a basis for rentable areas and make adjustments accordingly.
Whatever your methods, SpaceMan provides the tools to quickly re-allocate the
building and present the numbers in an analytical manner.

The decision on how to market space is usually a team effort, consisting of the
broker, Management Company, asset manager and the owner. Some of the key
market factors have to do with return on investment, quality of the product, the
strength of the local market and the broker’s style of leasing space.

Whatever the desired result, SpaceMan provides the tools for implementing a
consistent, mathematically correct set of rentable areas. There are many advantages
to providing accurate and consistent area calculations. One such advantage is due to
the increasing level of tenant contingency audits where spaces are measured and
claims are made pertaining to items ranging from base rent to the percent of building
occupancy. A potential for serious financial and legal discord is tremendous. For
this reason, a well documented, extremely accurate and consistent set of area
calculations is your best defense (especially when those questioning it are on a
contingency-fee basis).

If you plan to follow a published standard we recommend that you review the entire
document and use SpaceMan to understand the ramifications before you implement
area calculations for a property. If no standard exists, you should analyze the existing
leases for the property as a basis for determining area calculation standard and make
adjustments accordingly.

Where to Start Calculating Rentable Areas
For users who have never before attempted to calculate the rentable area of a
building, many ask, "Where do I start." In setting up a standard for calculating the
rentable area, you should break the process down into two steps.
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â How is each space measured (demised area)?

â How do I get from demised area to rentable area (factoring)?

In the first step, you must decide how each space in the building is going to be
measured. The only difficult part is to decide how to handle partitions that separate
adjacent spaces. For example, when an elevator shaft abuts a toilet room, which
room's area includes the shared partition? Most published guidelines provide a
detailed description on how to measure each space. Regardless of the methodology
you follow, it is generally good practice to start from the outside and work in. First
define the measuring points on the exterior wall to achieve the gross area.

A typical scenario is as follows:

Non-rentable core space, such as elevator shafts take the area of their
enclosing walls before:

Building common core space takes the area of their enclosing walls before:

Floor common core space takes the area of their enclosing walls before:

Retail, office or storage spaces.

On multi "tenanted" floors, the area of corridors usually include the area of
the walls that separates tenant space.

Factoring.
Calculating the Rentable Area by Type of Space

While a tenant might only be occupying a certain section of a floor, they are using
and/or benefiting from other amenities that are located on that floor or in that
building. The tenants usually share the square footage of these amenities. This
section describes how SpaceMan calculates the proportionate share of common
spaces. The logic behind this method of calculating the rentable area is very
straightforward. Keep in mind that:

1. Each space is assigned a Space Type.

2. Each Space Type is assigned to Apportionment Category.

3. The rentable area of tenant space is the usable area plus the
proportionate share of all common apportioned categories.

Before using SpaceMan to calculate rentable area, you must first make sure that all
spaces in the building have been assigned

Assigning Space Types to Categories
When you assign a space, SpaceMan calculates and stores the actual area. Also when
you are assigning the space, you specify a space type such as main lobby, office,
stair, etc. Each of the space types is then assigned to an allocation category such as
building common, floor common, etc. Using this method you can quickly re-classify
a space from one category to another and recalculate the area of the building as it
relates to the RSF for each tenant. To re-classify a space type from one category to
another:
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1. Position the cursor on a space and right-click. Select Assignment from
the data menu. When the Edit Space Assignment menu appears, click
on the Edit Type button.

2. Position the Space Type to be edited by using the directional buttons.

3. Click the Edit button.

4. From the Space Category drop-down menu, select a new type.

Floor Area Statistics
When you click on View Area Statistics from the Utilities pull-down menu, the
Floor Area Statistics form appears. On the right side of this form there is a listing of
all of the different area types.

The Floor Area Statistics screen shows the actual area of each allocation category on
the floor, as well as the current method of allocation, factors and rentable area. From
this screen you cannot change total usable area because that information is based on
how you assign each space. To show how each space on the floor is categorized,
select Show Assigned from the Assignments menu. Note that this is the same
graphic that is produced when you color-code a floor plan on Area Types.

Alternative methods of Calculating the Rentable Area
In addition to calculating the rentable area of a building by type of space, SpaceMan
also allows you to calculate the rentable area by:

â Specifying the rentable area for a floor.

â Applying a fixed factor on top of the calculated floor common factor.

â Applying the total factor to a floor.

Each of these methods are selected by clicking the check boxes next to the
appropriate item in the upper left hand side of the Floor Area Statistics screen. To
open this screen select View Area Statistics from the Utility menu.

Specifying Rentable Area for a Floor
This method allows you to specify the total rentable area for the floor. When using
this method, there is no need to assign common spaces on the floor, because they are
not entered into the equation when the factor is calculated.

Applying a Fixed off Floor Factor
In this method SpaceMan calculates the rentable area by applying a user-specified
factor to all office and floor common space. Using this method, you must assign the
office space as well as all floor common spaces on the floor.
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Chapter 7 Create a New Project or
Drawing

Creating a New Project
To create a new project, make sure that there is no other project open. If there is a
floor plan on your screen, that means that there is a project open and you must close
it.

If you have just started SpaceMan click Cancel on the Select file to open Dialog
box.

Select File at the upper left-hand corner of the screen. On the pull-down menu select
New Project.  Under New Project Location select the drive where you want to
store this project in.

When you enter a Project Name, you are creating a new directory. (i.e.
C:\smw\smsample)

The Project Description is the information that will be displayed in the left column
when opening up a drawing.

You will be prompted to select a Project Template for the new project. A template
is an existing project on your computer. Select a project folder to be used as a
template, which matches the type of project you want to create (i.e. Office, Retail,
and CAFM).

SpaceMan will copy the necessary data files for the new project.
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Create a New Drawing
Before you attempt to create a new drawing in SpaceMan, make sure you have a
CAD file to use as a background or reference file.

To Create a New Drawing if you have not Logged into SpaceMan

Start SpaceMan; click on Cancel at the lower right-hand corner of the Select file to
open Dialog Box. Select File at the upper left-hand corner of your screen. On the
pull-down menu select New Drawing. Next fill the Create New Drawing dialog
box (see details in this section).

To Create a New Drawing if you have just created a New Project or have
another drawing file open

Go directly to File at the upper left-hand corner of your screen, from the pull-down
menu select New Drawing. Next fill the Create New Drawing dialog box (see
details in this section).

Create New Drawing dialog box   

Type the Building Code that you are assigning. Type the Floor Code (i.e. 6th). Click
under SpaceMan File Name, select or type a path (project folder location) plus the
SpaceMan file name you are assigning. (i.e. C:\smw\smsample\230M-01)

Select Master file(S_M)

Enter the SpaceMan file name using the naming convention of BBBBB-FF, where
BBBBB is the building code and FF is the floor number.

Under Background CAD File Name, click on the background file name field; select
a path for the background and Highlight the CAD file name that you want to use in
your drawing.

When you click Ok, SpaceMan will create the new file and display the reference file.

To continue See Chapter on Delineating and Assigning a Space, Icon Descriptions
and Accuracy Toolbar.

Enable Rentable Area Calculations
If you want to activate SpaceMan's area calculation features, click on the Enable
Rentable Area Calculations box. Enter the Rentable Area for the floor if
appropriate.
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Adding and Editing Assignment Information
In order to attach data to a space, you must first assign the space to the database.
Aside from just providing information, data links SpaceMan to the database.

When you create a new space, remember to assign information to that space by click
on Add Assignment and then the newly created space.

The Assign Space data screen will appear. When you enter the information that you
want assigned to this space, it will automatically be saved in Access.

Edit Assignment
Allows you to change assignment information residing on the database. When you
click on this command, the Edit Space Assignment form appears. Simply edit the
information that you want to change, and Access will update the changes when you
save the floor plan.

You can alter the assignment information displayed on the floor plan relatively easy,
by changing the style. Click on the Edit Style button. For example, some people may
wish to look at a floor plan with the Space numbers and RSF while others may wish
to see the tenant name. Furthermore, users can customize styles with data from user-
specific tables.

Editing All Assignments

When you click on Edit All Assignments from the Assignment pull-down menu, the
Global Edit box will appear. From this screen you can:

Change the rotation and size of the assignment information.

Select the space type and assignment style.

Only select Include system assignments if you want all Space Labels changes (i.e.
core spaces, etc.).



PlanData Systems Corp. Index  ••  71

Index

A

Add Assignments 22
Add Boundary 19–21, 32–33, 39, 42
Administrative Rights 6, 61
Attribute 6, 47

B

Backing up Data 8
Basic Functions 6
Buildings 9, 27, 43, 46, 65

C

Close Drawing 13
Convert CAD Assignments 22
Convert CAD Entity 19–21
Create a New Drawing 12, 68–69
Cursors 10

D

Data Menu 6, 8, 16, 43–44, 48, 52, 67
Data Tables 6, 44, 52
Defining User Privileges 61
Delete Assignment 22, 41
Delete Assignments in Window 23
Delete Boundaries in Window 21
Delete Boundary 21, 32, 40
Delete Nibs in Window 21
Delete Text 23–24
Delete Text in Window 24

E

Edit All Assignments 22, 44, 70
Edit Assignment 22, 43, 48, 70
Edit Boundary 21
Edit Text 24

Export 16, 29

F

Field 5, 7, 17, 29, 49–52, 69
File Descriptions Option box 11
File Naming Convention Files 10
Floors 9, 11, 27, 66

G

Generating Graphics 25

I

Input Screens 7

K

Keyboard 7–8, 51

L

Layer Manager 18, 30, 33, 38
List Boxes 7
Logging On 6

M

Menu Commands 7
Mouse 7–8, 39–41, 43, 47, 48, 52
Move Assignment 22, 41
Move Text 10, 24

N

New Drawing 12, 68
New Project 12, 68–69

O

Open Drawing 12
Open Project 12
Opening/Retrieving a Drawing 11

P

Pan 10, 33
Print 13–14, 25–28, 32, 62
Printing Options 13–14
Projects 6, 9, 61
Pull-Down Menus 8, 12



PlanData Systems Corp. Index  ••  72

R

Record 7, 41, 50–61
Redraw Screen 18, 23, 33
Relational Database 5, 7, 49
Report on Current Drawing 28

S

Save 6, 8, 13, 16, 21, 28, 32, 46, 49, 51–52, 61–62, 70
Save As 13
Scenario Files 9, 11
Scenario Files Option box 11
Selecting a Building / Floor 11
Set Default View 18
Setup 13, 15, 20, 28, 31, 32, 46, 53
Show Area 23, 32, 34, 43
Show Pictures/Hide Pictures 24
Show Text 23
Space-Related Data 5, 9
Symbol Origins 19

T

Tables 6–7, 30, 44, 48–52, 62, 70
Trace Boundary 21, 43

U

Undo Last Delete 21–22

V

view 8–14, 16–18, 24–25, 28–30, 32–34


